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Laboratoire #6 

 
Système d’emmagasinage de charges d’un moteur DC 

 
Automne 2012 

 
 

1. Objectifs 
 

• Poursuivre la conception de PCBs 
• Dessin manuel de footprint 

 
2. Méthodologie 
 
Dans ce laboratoire, il sera question de concevoir un système qui emmagasine dans un 
condensateur les charges provenant d’un moteur DC. Les charges sont emmagasinées 
jusqu’à ce que l’utilisateur pèse sur un bouton poussoir à quel moment le condensateur se 
décharge par une LED pour la faire allumer. Le principe de base est illustré à la Figure 1. 

 
Figure 1. 

 
Pour concevoir ce circuit, il faudra commencer par créer 2 footprints et peut-être modifier 
les footprints qui sont déjà disponibles. Les 2 footprints à être créés sont un pont de 
diodes et le moteur DC. Si vous avez conservé le footprint du commutateur, vous ne 
devrez pas le refaire. Cependant, si vous ne le trouvez plus, vous devrez le recréer. 
Ensuite, vous aurez à placer les composantes ensemble sur un PCB et vérifier que les 
trous et les espacements sont de tailles adéquates. Finalement, il faudra délimiter votre 
circuit pour envoyer aux techniciens qui s’occuperont d’envoyer vos circuits à l’usine. 
Selon les disponibilités du personnel de laboratoire et des délais de fabrications, vous 
devriez recevoir vos circuits dans environ 3 semaines. À ce moment, vous aurez à faire 
les montages et à faire la soudure pour finalement montrer que votre circuit fonctionne. 
 
La taille de votre PCB ne devrait pas dépasser 1.5” x 1.5”.  
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3. Travail demandé 
 
Le présent laboratoire peut être séparé en 4 parties qui ne sont pas de tailles égales. Vous 
aurez à : 
 

- Dessiner à la main un circuit complet pour le système 
- Dessiner manuellement les footprints du pont de diodes et du moteur DC 
- Ajuster les autres footprints pour vous assurer que la taille des trous est adéquate 
- Faire le PCB du circuit complet 

 
Avant de poursuivre à la Section 1, assurez-vous que votre circuit est conçu et dessiné 
convenablement. Montrez et expliquez votre circuit au chargé de laboratoire qui validera 
votre circuit et vous laissera poursuivre à la Section 1. Vous serez noté sur cette partie.  
 
Section 1. Dessin de footprint manuel 
 
Dans cette partie du laboratoire, vous aurez à faire un footprint de façon manuelle. Il 
arrive souvent que les footprints necessaires ne soient pas disponibles. Dans ces cas, 
lorsque le boitier est standard et symétrique, il est intéressant d’utiliser le Component 
Wizard comme vous l’aviez fait au dernier laboratoire. Lorsque le boitier est différent, il 
faudra dessier un footprint de façon manuelle. 
 
La première idée qu’il faut comprendre c’est que le footprint n’est qu’un dessin qui 
représente la forme physique de l’objet. Lorsque nous ne sommes pas certains de notre 
coup, il est facile d’imprimer le footprint et de prendre des mesures pour s’assurer que 
nous avons exactement ce dont nous avons besoin. De plus, lorsque nous avons les 
composantes en notre possession, nous pouvons les placer sur le papier imprimé pour se 
donner confiance avant de poursuivre. Évidemment, lorsque vous aurez acquis plus 
d’expérience, ce genre de procedure deviendra moins nécessaire.  
 

a) Pont de diodes 
 
Pour dessiner un footprint manuellement, nous commençons de la même manière que 
lorsque nous le faisons avec le Component Wizard : nous ajoutons un PCB Library à 
notre projet (Add New to Project → PCB Library). 
 
Dans ce premier exercice, nous allons faire le footprint d’une puce (DF04) qui contient 
un pont de diodes. Puisque la puce a un boitier de type DIP à 4 pattes qui est symétrique, 
il serait possible d’utiliser le Component Wizard. Cependant, nous allons créer son 
footprint de façon manuelle pour apprendre une autre façon de faire. 
 
Commencez par trouver la fiche technique de la puce en cherchant DF04 sur Google. Le 
document que vous trouvez devrait parler d’un pont de diodes (« Bridge rectifier » en 
anglais) qui supporte jusqu'à 1A de courant. Une fois trouvé, regardez le dessin 
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mécanique pour connaitre les dimensions requises. Les paramètres qui vont nous 
intéresser sont les suivants : 
 

- La position et la distance entre les pattes : nous irons mettre des plots avec des 
trous à ces endroits. 

- La taille des pattes : il faudra spécifier la taille des trous à percer pour 
accommoder nos pattes. 

- La taille générale du boitier : nous allons dessiner un rectangle avec un point de 
repère pour savoir comment placer et souder notre pont de diodes lorsque nous 
aurons à le faire.  

 
Revenons a Altium. Vous devriez avoir une fenêtre grise vide à l’intérieur de laquelle 
vous pouvez dessiner votre footprint. Commencez par ajouter un plot circulaire et placez-
le sur le marqueur illustré à la Figure 2. Ce marqueur représente les coordonnées (0, 0). 
Rappel : L’icône pour ajouter les plots se trouve en haut de la fenêtre et est représentée 
par un cercle avec un rond à l’intérieur. 
 

 
Figure 2. 

 
Une fois que c’est fait, retournez voir la fiche technique pour connaitre la distance entre 
les pattes. Nous aimerions orienter notre puce à la verticale, tel qu’illustré à la Figure 3. 

 
Figure 3. 

 
Nous allons imaginer que le premier plot que vous aviez placé est la patte négative (-) sur 
le diagramme. Allez voir la distance entre la patte – et la patte + dans la fiche technique. 
Elle vous donnera une distance (minimale et maximale) en millimètres. Choisissez une 
valeur quelque part entre ces deux valeurs et notez-la. Vous aurez encore à lire quelques 
explications avant de placer les autres plots. 
 
Pour vous donner une idée comment placer les objets, il y a plusieurs outils qui peuvent 
être intéressants : les coordonnées absolues en bas à gauche de l’écran, la taille du 
quadrillage et la règle. En regardant en bas à gauche de votre écran, il est possible de voir 
les coordonnées de votre souris en X et en Y (Figure 4). 

 
Figure 4. 
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Ces coordonnées peuvent être montrées en termes de millièmes de pouce (mil) ou en 
termes de millimètres (mm). Dans notre cas, comme vous allez le constater, il sera 
intéressant de prendre nos mesures en millimètres. Pour changer les unités, il est possible 
de peser sur la lettre q ou l’autre manière serait d’aller dans View → Toggle Units. À 
chaque fois que vous faites cette action, Altium changera d’unités entre mil et mm. 
 
Le deuxième outil pratique est la taille du quadrillage. La taille du quadrillage peut être 
intéressante à utiliser pour connaitre approximativement la taille des objets qu’on dessine. 
En effet, en sachant qu’un carré est d’une certaine dimension, il est possible de connaitre 
les distances en comptant le nombre de carrés. La taille du quadrillage est présentée en 
bas à gauche à côté des coordonnées. Il est aussi possible d’ajuster la taille du quadrillage 
avec le bouton en haut de la fenêtre tel qu’illustré à la Figure 5. Cliquez sur le triangle à 
côté et sélectionnez la précision qui vous convient (en mm). Vous pouvez commencer par 
0.1mm et ensuite, le changer comme ça vous plait. 
 

 
Figure 5. 

 
Il est important de savoir qu’il y a 2 tailles de carrés. Il existe des carrés de petite taille et 
des carrés plus grands. Lorsqu’on se rapproche assez (zoom), il est possible de les voir 
(Figure 6). Dans cette figure, nous voyons que les petits carrés sont plus foncés (petit) et 
des carrés plus pâles (grand). La taille de 0.1mm correspond aux carrés foncés. 
 

 
Figure 6. 

 
Le dernier outil que nous allons présenter est la règle. La règle nous permet de mesurer la 
distance entre deux points et nous aide à confirmer que les mesures sont bonnes. Pour 
vous en servir, vous pouvez peser sur CTRL-M ou aller dans le menu et sélectionner 
Reports → Mesure Distance. Par la suite, vous devrez cliquer sur deux points entre 
lesquels vous voulez trouver la distance. Essayez de faire cette manœuvre quelques fois 
pour vous assurer de bien comprendre l’explication (qui risque d’être nébuleuse). 
 
Revenons à la création du footprint. Nous allons maintenant placer le deuxième plot. Le 
document vous aidera à faire cette procédure, mais, pour les autres plots, vous aurez à les 
placer seul. Le prochain plot que nous voulons placer est la sortie positive (+). En 
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regardant la fiche technique, nous voyons que la distance qui sépare le – et le + est entre 
5mm et 5.2mm. Nous allons choisir 5.1mm. 
 
Pour nous donner une idée de base, nous pouvons commencer par compter les carrés. Il y 
a 5 petits carrés à l’intérieur d’un gros carré et chaque petit carre correspond a 0.1mm. Un 
gros carré aura donc une taille de 0.5mm et 10 de ces gros carrés nous amèneront proche 
de l’endroit où nous voulons être. 
 
Alors, partez du CENTRE du plot que vous aviez placé, comptez 10 gros carrés vers le 
haut et placez un plot à cet endroit (Figure 7). Votre placement d’a pas besoin d’être 
précis à ce moment-ci puisque vous allez le réarranger par la suite. 

 
Figure 7. 

 
Dans la figure précédente, vous devriez voir que les plots ne sont pas alignés : ce n’est 
PAS une bonne chose. Faites les ajustements nécessaires pour les enligner et pour qu’ils 
soient séparés de 10 gros carrés (5mm) et de 1 petit carré (0.1mm). Finalement, pour 
valider le tout, utilisez la règle pour voir que la séparation est effectivement 5.1mm 
(Figure 8). Une autre façon de procéder est de regarder les coordonnées (en bas à 
gauche) : sachant que votre premier plot est à (0, 0), il faudrait simplement que le centre 
de l’autre plot soit à la position (0, 5.1mm). Vous pouvez donc placer votre souris au 
centre du deuxième plot pour voir si la position est (0, 5.1mm). C’est d’ailleurs un des 
bénéfices de placer son premier plot à l’origine (0, 0). 

 
Figure 8. 
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C’est maintenant à votre tour de dessiner les 2 autres plots. Le résultat final devrait 
ressembler à la Figure 9 : 
 

 
Figure 9. 

 
Une fois que c’est fait, nous allons voir si la taille des trous est adéquate. En regardant la 
fiche technique, nous voyons que la taille nécessaire pour un trou doit être entre 0.41mm 
et 0.51mm. De plus, nous savons que le procédé de fabrication réduira la taille du trou 
spécifié d’environ 0.25mm (à peu près 10 mil). Pour compenser pour cette réduction, il 
faudra ajouter cette taille à la dimension du trou désiré. Dans ce cas-ci, nous devons 
prendre une taille de 0.51mm pour s’assurer que, même dans le pire cas, le trou sera 
adéquat. En ajoutant 0.25mm, nous nous retrouvons avec 0.76mm. Double-cliquez sur un 
plot. Vous devriez obtenir une fenêtre semblable à celle de la Figure 10. En regardant la 
taille du trou par défaut, nous voyons que c’est déjà 0.762mm. Nous n’avons donc rien à 
faire à ce niveau. En temps normal, nous devons ajuster la taille du trou pour 
correspondre à la taille de la patte. Si le trou était trop gros, la soudure pourrait être 
difficile à faire tandis que si le trou était trop petit, il pourrait être impossible d’insérer la 
puce. Pour faciliter la soudure et pour assurer une bonne intégrité mécanique, il y a une 
région « grise » à l’extérieur des trous qui est spécifiée par la partie encadrée à droite de 
la fenêtre (Figure 10). Cette région est typiquement proportionnelle à la taille des trous, 
mais puisque nous ne changeons pas la taille des trous, nous pouvons garder les valeurs 
par défaut.  
 

 
Figure 10. 

 
La dernière étape dans la création d’un footprint est le dessin de la puce (ou de la 
structure physique qui ira à cet endroit). Pour représenter la puce DF04, nous allons 
dessiner un rectangle et une barre pour identifier comment la puce doit être orientée (par 
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exemple, il est possible de l’insérer à l’envers). Ce dessin sera fait sur une couche qui est 
non-métallique qui s’appelle un « silk screen » ou un « overlay », selon les outils. À 
l’usine, ils vont dessiner cette couche avec de l’encre blanche (pas toujours blanc). 
 
Pour dessiner le overlay, commencez par regarder en bas de votre écran (Figure 11). 
Vous devriez voir des noms comme Top Layer, Bottom Layer, etc. Ces noms représentent 
les couches auxquelles vous avez accès. Ce qui se trouve à gauche de Top Layer c’est la 
couche qui est présentement active. C'est-à-dire que, si la couche est rouge (Top Layer) et 
que vous dessiniez une ligne, le résultat sera une ligne en cuivre sur la couche du haut. 
Cliquez maintenant sur Top Overlay. Vous devriez voir que la région à gauche est 
devenue jaune pour correspondre à la couche Top Overlay (qui veut dire « encre 
blanche » sur la couche du haut). Si vous dessiniez une ligne maintenant, l’usine saura 
qu’il faut dessiner une ligne avec de l’encre et non avec du cuivre. C’est d’ailleurs cette 
couche que nous allons utiliser pour faire le dessin de la puce. 
 

 
Figure 11. 

 
 
En regardant les dimensions du boitier sur la fiche technique et en estimant les 
dimensions d’espacement, dessiner le boitier de la puce DF04. Vous pouvez utiliser les 
outils en haut de la fenêtre (Figure 12). Bien que plusieurs outils soient encadrés, vous 
n’aurez surement besoin que de l’outil pour tracer des lignes droites. Pour le traçage de 
ces dimensions, il est préférable d’utiliser les valeurs maximales. Ceci nous permettra de 
nous assurer d’un espacement adéquat pour placer la puce et pour pouvoir souder 
convenablement. Il arrive parfois que les lignes des Overlays tombent sur les plots : dans 
ces cas, il faut s’arranger pour modifier le dessin du Overlay. Sachant que le Overlay sert 
a « réserver » une place pour le boitier et a nous guider à orienter l’objet, il serait 
acceptable de réduire la dimension horizontale du boitier dans ce cas-ci. 
 

 
Figure 12. 

 
Le résultat final pourrait ressembler au dessin de la Figure 13. 

 
Figure 13. 
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Avant de terminer, il serait pertinent de changer le nom de votre footprint. Si plusieurs 
footprints se retrouvaient à avoir le même nom (qui est Component_1 par défaut), Altium 
prendra toujours le premier qui est dans sa liste de librairies. Pour régler ce problème, il 
suffit de changer le nom de chaque footprint. Ceci se fait en cliquant sur Tools → 
Component Properties et en changeant le nom. Il est toujours préférable d’utiliser un nom 
qui a un sens : par exemple, pontdiodes_dip4. 
 
Une fois complété, sauvegardez le fichier pour que vous puissiez vous en servir plus tard. 
À ce stade, il est aussi bon de noter ce que chaque patte représente : Patte 1 représente la 
sortie positive, patte 0 représente la sortie négative et les 2 autres pattes représentent les 
deux polarités du signal en entrée. 
 

b) Symbole schématique 
 
Une fois créé, il y a 2 façons de se servir de ce footprint. La première option est celle que 
nous avions utilisée au dernier laboratoire : utiliser un symbole qui existe déjà et 
l’associer à notre footprint. Pour ce faire, cependant, il faut s’assurer que le numéro de 
nos pattes corresponde aux numéros de la pièce : par exemple, si la patte numéro 0 du 
symbole schématique était la sortie +, il faudrait changer la numérotation de notre 
footprint.  
 
L’autre option, celle que nous allons explorer aujourd’hui, c’est de dessiner notre propre 
symbole schématique. Pour ce faire, nous allons commencer par ajouter une library de 
type schématique dans notre projet : Add New to Project → Schematic Library.  

 
Les outils que nous allons utiliser sont en haut de la fenêtre (Figure 14). De façon plus 
particulière, nous allons nous servir de la deuxième icône encadré. Dans cette section, il y 
aura des options pour créer des rectangles et ajouter des pattes : pour les buts de ce 
laboratoire, nous allons nous restreindre à ces deux commandes. 

 
Figure 14. 

 
Commencez par créer un rectangle en cliquant sur la bonne icône. Un rectangle d’une 
certaine taille devrait apparaitre et s’accrocher à votre souris. Déposez le coin bas-gauche 
de votre rectangle à l’intersection des lignes du plan cartésien et double-cliquez. Vous 
devriez obtenir un résultat semblable à la Figure 15. Il était possible de mofidier la taille 
de votre rectangle, mais ce n’est pas nécessaire à ce point-ci. 
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Figure 15. 

 
Nous allons maintenant vouloir ajouter des pattes : deux de chaque bord. Sachez, en 
passant, que les pattes peuvent être mises n’importe où et que ça n’a pas besoin de 
correspondre physiquement à votre footprint. Par exemple, il serait possible de mettre les 
4 pattes à gauche du schéma si ça me plaisait. Pour ce laboratoire, nous allons mettre les 
entrées à gauche et les sorties à droite. Ajoutez les pattes de façon semblable à la figure 
16 (à gauche). Il est important de  s’assurer qu’un chiffre se trouve sur le fil et que l’autre 
chiffre se trouve à l’INTÉRIEUR de la boite (vous devrez surement faire tourner deux 
des pattes pour que ça arrive bien). 

   
Figure 16. 

 
La dernière partie est de nommer les pattes et de les faire concorder avec notre footprint. 
Il y a 2 nouveaux termes à apprendre : Display Name et Designator. Le Display Name est 
le nom qu’on voudrait afficher à l’usager. Ce nom n’a aucun but autre que d’informer 
l’usager. Le Designator est le terme qui associe le footprint au diagramme. Par exemple, 
le Designator 0 correspondra à la patte 0 du footprint. Sachant que la patte 0 du footprint 
correspond à la sortie négative, il faudrait éventuellement qu’on renomme les pattes pour 
mettre le Designator 0 à droite. Si vous ne comprenez pas immédiatement, ne vous 
inquiétez pas ; le texte devrait vous guider pour que vous puissiez faire les premiers 
changements  
 
Dans ce laboratoire, nous changerons les caractéristiques des pattes en 2 phases : une 
première phase où nous ne changeons que le Display Name et une deuxième phase où 
nous changeons les Designator. Bien que les deux changements puissent être faits en 
même temps, le raisonnement sera plus clair pour ceux d’entre vous qui ne se sentent pas 
encore à l’aise. 
 
Commencez par cliquer sur la patte en bas à gauche et changez le Display Name pour que 
ça devienne sig2. Faites la même procédure pour les autres pattes pour que ça ressemble à 
la Figure 17. 

 
Figure 17. 

 
Une fois complété, nous allons recliquer sur chaque patte pour changer le Designator. Le 
document vous guidera pour changer Sig1 et vous pourrez faire les autres seul. Double-
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cliquez sur la patte Sig1 qui est une entrée. Sachant que les signaux en entrée sont les 
pattes 2 et 3 du footprint, nous devons changer le Designator de Sig1 pour que ce soit 2 
ou 3 (ça ne change rien dans le cas d’un pont de diodes). Pour les buts de l’exercice, nous 
allons choisir 2 et donc, il faudra changer le Designator de Sig1 pour que ce soit 2. Faites 
le même exercice pour les autres pattes. 
 
La dernière partie est d’associer un footprint « par défaut » à notre symbole schématique. 
Cette étape est facultative parce que, comme nous le savons déjà, il est possible de 
changer le footprint de n’importe quel symbole à n’importe quel instant. Cependant, ça 
peut être pratique si nous avions l’intention de nous en servir souvent. Cliquez sur Add 
Footprint en bas de la fenêtre. 
 
Une nouvelle fenêtre devrait apparaitre pour vous demander quel footprint utiliser. Vous 
aurez à suivre des étapes qui sont semblables à ce que vous aviez fait au dernier 
laboratoire. Cette fois-ci, cependant, le document ne vous donnera pas toutes les étapes à 
suivre. L’idée générale est 1) d’inclure la librairie PCB que vous venez de créer et 2) 
sélectionner le footprint. Lorsque vous aurez terminé, le bas de votre fenêtre devrait 
ressembler à la Figure 18. 

 
Figure 18. 

 
Sauvegardez votre symbole schématique pour que vous puissiez vous en servir 
éventuellement. 
 

c) Moteur DC 
 
Le dernier footprint/symbole schématique que vous aurez à créer est celui pour le moteur 
DC. Un moteur DC est une composante qui tourne quand on connecte une source entre 
ses deux fils. Ce même moteur va tourner dans l’autre sens si on changeait la côté positif 
et le côté négatif de la source. Si, à la place d’appliquer une tension, on décidait de 
MESURER la tension aux bornes des fils, on obtiendrait 0v lorsqu’il n’y a pas de 
mouvement. Cependant, lorsqu’on fait tourner le moteur (avec nos doigts, par exemple) 
et qu’on mesure la tension, nous devrions voir la valeur changer. Si on tournait dans la 
direction inverse, la tension sera de signe inverse. Lorsqu’on utilise un moteur de cette 
façon, ça devient un générateur. Nous allons justement utiliser ce moteur/générateur pour 
charger le condensateur pour ensuite le décharger dans la diode. 
Pour faire le footprint, vous y allez comme vous le voulez. Ce moteur est un peu plus 
petit de la taille de votre pouce et il y aura 2 longs fils qui sont utilisés pour connecter le 
moteur au circuit. Il est possible que vous vouliez connecter les fils en « surface » ou 
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peut-être que vous voulez faire des trous, etc. La figure 19 nous montre la différence 
entre ces deux options. 

   
Figure 19 

 
Si vous décidiez d’utiliser des plots sans trou (donc, en « surface »), nous pouvons 
procéder de la façon suivante. Commençons par ajouter des plots qui ont des trous. Par la 
suite, nous allons double-cliquer sur le plot pour obtenir la fenêtre de la Figure 20. 
 

 
Figure 20. 

 
Dans la section encadrée à gauche (Figure 20), sélectionnez la couche du dessus (Top 
Layer). Par défaut, le système pense qu’un plot connecte la couche du haut et la couche 
du bas et c’est la raison pour laquelle il met un trou. En n’ayant qu’une seule couche, il 
n’y a plus de raison d’avoir de trous.  
 
Ensuite, nous allons vouloir changer la forme de l’objet pour obtenir un rectangle à la 
place d’un cercle. Pour ce faire, il faut cliquer sur la flèche (triangle) dans la section 
Shape pour choisir Rectangular à la place de Round. Finalement, changez les tailles X-
Size et Y-Size pour que ça corresponde à la dimension des fils (à peu près). Une fois 
complété, ajoutez un deuxième plot de la même taille à la distance choisie. Finalement, 
créez le dessin de contour de l’objet pour, encore une fois, qu’on sache qu’il ne faut pas 
mettre d’objets en dessous de cette section.  
 
Une fois terminé, sauvegardez votre fichier et créez un symbole schématique pour votre 
moteur DC (que vous devez aussi sauvegarder). 
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Section 2 : Circuit final 
 
La dernière partie du laboratoire est le dessin du circuit que vous enverrez à l’usine. 
Suivez à peu près les mêmes étapes qu’au dernier laboratoire sur les PCBs (laboratoire 
4). Le circuit à monter est le circuit que vous aviez montré au chargé de laboratoire en 
début de séance et le résultat doit être un PCB complet. 
 
Dans votre PCB, vous aurez besoin des éléments suivants : 
 
Composante Footprint 
Moteur DC Footprint fait par vous 
Pont de diodes  Footprint fait par vous 
Boutton poussoir  Footprint fait par vous 
Condensateur  Axial-0.9 (0.8mm + 0.25mm de plaquage) 
LED  LED-0 (0.6mm + 0.25mm de plaquage) 
 
Notes : 

- N’oubliez pas de faire un plan de masse 
- Imprimez le PCB pour vous assurer que les composantes entrent bien dans les 

places allouées et que les trous soient de la bonne grosseur 
- Vous devez ajouter du texte pour identifier votre design (Voir la section suivante) 
- Vous devez créer une bordure autour de votre design avec la couche KEEP OUT 

(Voir la section qui vient après l’ajout du texte).  
 

a) L’ajout de texte 
 
Il arrive souvent qu’on veuille mettre du texte sur le circuit imprimé. Ceci pourrait être 
pour identifier le concepteur, pour identifier le circuit ou pour donner de l’information 
supplémentaire. L’ajout de texte peut être fait avec l’outil de texte qui se trouve en haut 
de la fenêtre (Figure 21). Pour vous en servir, commencez par sélectionner la couche Top 
Overlay (encre blanche). Cliquez ensuite sur la lettre A en haut de la fenêtre et placez le 
texte où vous voulez. Vous pouvez maintenant double-cliquer sur le texte pour modifier 
le texte. 

 
Figure 21. 

 
Lorsque l’usine nous enverra les PCBs, ils se retrouveront tous dans la même boite. Pour 
savoir à qui appartient chaque PCB, il est important d’identifier le concepteur et 
d’identifier la fonction du PCB. Un exemple de texte possible se trouve à la Figure 22. 

 
Figure 22. 
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b) Indicateur de Bordure 
 
Lorsque vous aurez fini de dessiner votre circuit, il devra être envoyé aux techniciens 
pour être combiné avec les autres circuits. Le résultat de cette combinaison est un dessin 
énorme qui contient les circuits de tout le monde. Ce travail s’appelle la « panelisation ». 
Pour indiquer au logiciel où votre circuit se trouve, il faut tracer une ligne autour et il faut 
réduire la taille de la fenêtre (la section noire). Ceci se fait premièrement en dessinant 
autour du circuit avec une couche appelée Keep Out Layer. Cette couche ne représente 
rien physiquement. Elle ne sert qu’à indiquer que votre design se trouve à l’intérieur de 
ces limites. 
 
Pour ce faire, nous commençons par sélectionner la couche Keep Out en bas de la fenêtre. 
Par la suite, on dessine en utilisant l’outil pour tracer des lignes en haut de la fenêtre 
(Figure 23). NOTE : Ce n’est PAS le même outil que nous utilisons pour dessiner les 
connexions. Assurez-vous que la ligne que vous tracez soit de couleur mauve (Keep Out) 
et non de couleur rouge (Top Layer).  
 

 
Figure 23. 

 
Créez une boite mauve autour de votre circuit. Le résultat final devrait avoir l’allure de la 
Figure 24. 

 
Figure 24. 

 
Pour réduire la taille de la région noire, vous devez sélectionner vos 4 lignes faites par le 
Keep Out Layer. Ensuite, vous devez aller dans Design → Board shape → Define from 
selected objects (Figure 25). Votre région noire devrait maintenant être de la même taille 
que votre PCB. 

 
Figure 25. 
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Transmettez votre fichier PCB au technicien (fdeschen@uqac.ca) en mettant votre nom et 
prénom dans le nom du fichier prenom_nom.PcbDoc. 
 

4. Barème 
 
Vous aurez tous vos points si vous avez tout complété et montré au chargé de TD. 


